Dear Amira User,

With this document we would like to inform you about the most important new features, improvements, and changes in this version. Please read these Release Notes carefully. We would appreciate your feedback regarding this version. If you encounter problems, but also if you have suggestions for improvement, please report them to vsghotline@fei.com. We would like to thank you in advance for your efforts.

January 2015, the Amira and Avizo team
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>2</td>
</tr>
<tr>
<td>Overview</td>
<td>3</td>
</tr>
<tr>
<td>Amira – Enhancements and new features</td>
<td>4</td>
</tr>
<tr>
<td>New module names, new menus, and terminology changes</td>
<td>4</td>
</tr>
<tr>
<td>User interface enhancements</td>
<td>5</td>
</tr>
<tr>
<td>New and enhanced features</td>
<td>13</td>
</tr>
<tr>
<td>Scripting compatibility and enhancements</td>
<td>24</td>
</tr>
<tr>
<td>New file formats supported</td>
<td>25</td>
</tr>
<tr>
<td>New modules</td>
<td>26</td>
</tr>
<tr>
<td>Enhanced modules and editors</td>
<td>29</td>
</tr>
<tr>
<td>Performance improvements</td>
<td>31</td>
</tr>
<tr>
<td>Amira for FEI Systems – New image processing, analysis and quantification features</td>
<td>32</td>
</tr>
<tr>
<td>Quantification module replaced by new modules and components</td>
<td>32</td>
</tr>
<tr>
<td>Multi-Component Analysis modules</td>
<td>33</td>
</tr>
<tr>
<td>New modules and features</td>
<td>33</td>
</tr>
<tr>
<td>New XWind extension – Advanced CFD/FEA data extension</td>
<td>41</td>
</tr>
<tr>
<td>XPand extension</td>
<td>42</td>
</tr>
<tr>
<td>XScreen extension</td>
<td>42</td>
</tr>
<tr>
<td>Operating systems</td>
<td>42</td>
</tr>
<tr>
<td>Solved issues</td>
<td>43</td>
</tr>
</tbody>
</table>
OVERVIEW

Amira for FEI Systems 6.0 is a major evolution of the Amira product family including new extensions, enhancements of the user interface for ease of use and simplified workflows, new and enhanced features, and performance improvements.

In addition to Amira Multi-Component Analysis option, already included by default in its previous version, Amira for FEI Systems 6.0 now also includes Amira XImagePAQ extension, the advanced Image Processing, Analysis and Quantification extension. Amira XImagePAQ provides advanced tools for image enhancement, simplified and automated segmentation, and extensive measurement and quantification of objects, cells, and tissue features.

About Amira and Avizo

Amira is the pioneer 3D data visualization and analysis software product for life sciences. Avizo is an application dedicated to materials sciences and industrial inspection that originated from Amira. Amira and Avizo share the same platform and have many common features. Both Amira and Avizo have introduced many specific improvements over the past. As it is our priority to always improve user experience, we are glad to announce that Amira 6.0 benefits from many of the well-proven and most appreciated features of Avizo, while still focusing on life sciences applications.
AMIRA – ENHANCEMENTS AND NEW FEATURES

NEW MODULE NAMES, NEW MENUS, AND TERMINOLOGY CHANGES

NEW MODULE NAMES AND NEW MENUS

One of the major changes in this release is choosing more intuitive module names in order to improve the learning curve and usability of Amira. The tooltip displayed when hovering the mouse over a module will include the previous module name if it differs from the old one by more than whitespaces. A search field is also available for retrieving modules by their previous names (see dedicated section below).

Module categories and menus have also been reorganized to make it easier for users to find the desired functionality.

You will find on top of the online help index page a link called Switching to Amira 6 leading to an index table of modules’ former names and categories and their corresponding new names and categories in Amira 6.0.
NEW TERMINOLOGY: AMIRA PROJECTS

To avoid confusion and make Amira concepts more easily understandable, a set of active data objects and connected modules is now called a Project instead of a Network. Accordingly, the area where the network is graphically displayed is now called the Project View rather than the Pool. Also, menu items such as Save Network have been replaced by Save Project, etc.

USER INTERFACE ENHANCEMENTS

NEW START PAGE

When Amira is launched, a Start page opens, giving you access to the most frequent tasks and useful information:

- Recent data, recent projects
- Open Data, Open Project, and Blank Project shortcuts
- Easy access to help pages, tutorials, webcasts...
- Latest news regarding Amira product family and FEI events
- Community links
The Start page can be disabled but remains available at any time from the workroom toolbar (see next section for more details about workrooms and the workroom toolbar).

WORKROOM CONCEPT

The Amira 6.0 user interface provides an easy and fast way to switch between application areas. With the user-friendly workroom concept, several dedicated components are accessible as independent applications assembled together into the general Amira platform. Each component provides its own specific interface, dedicated tools, and visualization options. Since switching between different components is possible through a simple toolbar, the user can explore and approach complex data sets using dedicated tools in the workrooms, and keep a clear overview in the general-purpose framework.

Note: Users of previous versions of Amira might be familiar with the sub-application concept. The workroom concept is an evolution of the sub-application concept.

The following components are currently available as workrooms:

- Start page
- Project View
- Segmentation Editor
- Filament Editor
- Multiplanar Viewer
- Animation Director
USER INTERFACE RENEWAL

Amira 6.0 has undergone a global user interface renewal.

- Amira panels are all dockable. It is now possible to reorganize Amira layout by moving panels interactively. To detach a panel window, drag its title bar.
- The Stop button is now next to the progress and status bar, and is no longer part of the Properties panel.
- Note that the Console is now hidden by default. A shortcut to the Console has been added in the status bar (in the lower right corner of the user interface). The Console can also be displayed or hidden using the [Ctrl + Alt + A] shortcut.

- In the Project View you can switch to pan mode with the [Esc] key or keep the middle mouse button pressed.
- Pressing [H] while a data or a display module is selected will hide all from the 3D viewer except for this data or display module. This can also be done from the Project menu or the Object Popup option menu (see the section dedicated to the Object Popup below).
- Finally, the Project View icons have been redesigned to improve readability.

AUTOMATIC DISPLAY

When adding a new data object in Amira’s empty Project View, a basic display module is now automatically connected to it to offer a first preview.

This feature can be enabled, tuned, and disabled from the Auto-Display panel in the Preferences dialog. You can choose to automatically connect a display module only to newly loaded data objects, or to both newly loaded and computed data objects, or only to the first loaded data object. For each data type a display module is recommended by default. You can change it as you wish.
The automatic display feature can also be easily enabled and disabled from the Project View toolbar dedicated button.

**NEW OBJECT POPUP – A MODULE FINDER**

The new **Object Popup** is a new component replacing the former context popup menu, used for attaching modules to a specific object. The Object Popup can be accessed by right-clicking on an object in the Project View or by pressing [Ctrl + Space] if an object is selected.

A search engine allows retrieval of modules or objects by name without navigating through the category explorer. An auto-completion list shows the matching objects and categories, including older objects that were renamed or deprecated and replaced by new ones. The search area has a configuration menu (arrow button on the right side) for selecting the types of items to be searched. It is also possible to extend the search to a full documentation search.

An explorer allows browsing the categories of object items that can be attached to an object selected in the Project View. The explorer includes favorites, recents, editors, and template-specific categories. The list of favorites and recently used modules is persistent across Amira sessions.

A preview panel is used to display a short description of an object when it is selected in the explorer, to add or remove an object in the Favorites category (star icon), and to create an object, or access an object’s help page.
An Options button (top left) gives access to object operations - hide, remove, duplicate, rename.

Save Data As... and Export Data As... buttons allow saving as, or exporting a data object to disk.

To create or attach an object, you can double-click the object entry in the explorer, or press the [Enter] key when the entry is selected, or press the Create button in the preview panel.

Pressing [Ctrl] while right-clicking on an object will display the list of favorite items of the Object Popup. A simple click on the item of your choice will create it.
NEW CREATE OBJECT POPUP MENU

Like the new Object Popup, the new Create Object popup menu is a new component replacing the previous Create context menu, used for creating modules or data objects that cannot be accessed via the Object Popup. The Create Object popup menu can be accessed by a right-click in the Project View or by the top menu Project.

This popup menu looks and works like the new Object Popup within the Project View.

NEW TABLES PANEL

The Tables Panel becomes the central place to display all spreadsheets. You can tab, cascade, or tile the spreadsheets windows within this panel. Like other panels, the Tables Panel can be detached and docked freely.

NEW VIEWER OPTIONS

A new toggle button Link Objects Visibility has been added to the viewer toolbar. When this toggle is on, changing visibility of an object will apply at once to all open viewers.

New convenience options have been added in the viewer popup menu to control the visibility of display modules:

- Display the same objects in the extra viewer (viewer id 4)
- Hide all objects for the viewer
- Show all objects for the viewer
- Link the visibility of objects across all viewers (i.e., from viewer ids 0 to 5)
- Copy the visibility status of objects from one viewer to another
- Display the viewer identifier in the viewer
- Display the viewer identifiers in all viewers

Spin animation is now off by default and can be enabled in the Preferences entry of the viewer’s popup menu.

**WARNING DIALOGS**

Some warning dialogs can now be disabled so they appear only once. You can restore disabled message boxes through the Restore Defaults... button in the Preferences General panel.
DOCUMENTATION IMPROVEMENTS

A navigation bar at the top of the help pages improves the navigation through Amira online documentation.

The online documentation now only displays by default the contents available with the installed licenses. Users who would like to browse all the features of the product including those locked by missing licenses, can enable this in the General panel of the Preferences dialog.

The index generated during the first use of the documentation search tool is now kept on disk so that it does not need to be rebuilt on each restart of the application, making research faster.

In a web browser, all Amira and Avizo product family documentation can be accessed by selecting the product of your choice in the top left combo box.

This requires a compatible web browser (Internet Explorer or FireFox) with cookies enabled. The web browser may ask for a user confirmation about script execution.

It is now possible to enable or disable the dockability of the Help panel from the Layout tab of the Preferences dialog.

MORE TOOLTIPS

Many tooltips providing short descriptions have been added for:

- Ports
- Module names in popup menus
- Modules in Project View, even when not selected
- Editors

Tooltips also provide the prior module names.
DATA INFO TAGS ENHANCED

The displayed data information has been clarified for image data types. New port Data info has been introduced. Information on optional data window and range calibration is now also displayed.

GERMAN VERSION OF AMIRA

A German version of Amira is now available. You can switch to the German user interface by selecting Deutsch in the Language section of the General panel of Preferences. Please note that documentation is still available only in English.

NEW AND ENHANCED FEATURES

NEW ANIMATION DIRECTOR

The Animation Director is a powerful replacement for the familiar Demo Maker module and related Demo Director GUI. It allows you to create and edit key frame animations and demos with an intuitive timeline panel. You can start the Animation Director by pressing the dedicated button in the workroom toolbar, or by selecting Animation in the Window main menu.

With the default layout, the Animation Director window appears docked below the viewer window. You will also notice Stopwatch icons added next to components such as modules, ports, and viewers.
You can compose an animation by moving the orange time cursor in the extensible timeline, then use stopwatch icons to add events in the key frame event tracks, and modify events in the event tracks once they have been added below the timeline. You can double-click on the time ruler to set the current time, as alternative to moving the time slider. You can zoom and pan the timeline. The media control buttons allow animation playback, and setting the time cursor to the next or previous event.

You can create multiple new animations and select any as the current animation.

To create a movie, you will toggle the *Movie Creation* button in the Animation Director panel which shows the *Movie Maker* interface.

A play speed factor can be set in the time management options (*More options* button). Once set, the play speed factor is indicated in the control panel above the current time.
In the User's Guide chapter *Animations and Movies*, the Demo Maker tutorial has been replaced by a new tutorial about the Animation Director. The section *Creating movie files* has also been updated.

By default, when loading an existing animation, any included Demo Maker module(s) remain hidden in the Project View and are automatically converted into Animation Director content. This can be disabled in the Preferences General panel by checking the option *Use Legacy Demo Maker*.

**NEW LOAD FILE DIALOG**

The dialogs used for opening and saving files are now implemented using native file dialogs. This allows you to benefit from all operating system specific enhancements, and especially a huge performance increase when browsing directories containing a large number of image files. For overriding automatic format recognition, use the new *Open Data As…* item in main File menu. After selecting the file(s) to load, the *File Format Selection* dialog is displayed.

**NEW MODULE PICKING FROM 3D VIEW**

A new viewer tool allows you to select a module in the Project View by just picking on a visual representation in the 3D view. When several modules of the same type are displayed, this feature makes it easier to select the right one.

**NEW MOVE-SENSITIVE QUICK PROBE**

A *Quick Probe* feature, accessible from the viewer toolbar, allows displaying the value and coordinates of a voxel using the mouse. The Quick Probe button supports three modes: move sensitive, click sensitive, and disabled.

By default, Quick Probe is move sensitive i.e., the voxel value and coordinates under the mouse cursor are displayed in the progress bar. In click-sensitive mode, the value and coordinates are displayed if the [Shift] key is pressed and the visualization in the viewer is clicked on with the left mouse button.
NEW COLORMAP EDITOR

The Colormap Editor has been redesigned to improve usability. The new Colormap Editor’s user interface has a more compact layout and is dockable like other Amira windows, so it can be more easily used permanently. You can open the Colormap Editor by pressing the dedicated button in the workroom toolbar, or by selecting Colormap Editor in the Window main menu.

The Colormap Editor automatically selects the colormap depending on the selected data and display module. The opacity curve (alpha curve) is overlaid on top of the data histogram. You can easily change the opacity curve segments or set predefined curves.

The Edit colormap gradient button in the lower right allows editing color keys with the standard Amira Color Editor. Color keys can be defined with two colors for Step interpolation.

It is possible to easily reverse the colormap and the alpha curve in the Colormap Editor by selecting the corresponding options.

COLORMAP PORT ENHANCEMENTS

The Edit menu of the colormap port has been slightly redesigned.

It is possible to take into account or not the transparency of a colormap by enabling or disabling the new Transparent option. Note that this will have no effect on display modules that already handle transparency another way, such as Ortho Slice with its Transparency port, Isosurface with the Draw Style port...
Adjust range and Zoom to options are combined in the same submenus.

When the mouse is over the colorbar, pressing on the space bar zooms to range and to data min-max alternately.

PORT SHARED COLORMAP

A new colormap port named Shared Colormap has been added to the data objects. The principle of this port is to specify a colormap for a data object so that the modules attached to this data automatically use the specified shared colormap. When a new colormap is connected to this port, all the modules connected to the data automatically update their connected colormap.
NEW “SAVE DATA AS” AND “EXPORT DATA AS” POLICY

The *Save Data As* command now allows you to save data only in native file formats. A native file format is a file format that can save all of the data properties in Amira. If you want to save your data in a non-native file format, you must now use the new dedicated item *Export Data As*. The file dialog will present a list of all file formats suitable for saving that data object, native or not.

*Save Data As* now renames the data object in the Project View according to the saved file name. As a project keeps track of the new file associated with the data object, a subsequent *Save* [Ctrl + S] will update that file and the project will refer to that file when saved and reloaded.

On the other hand, *Export Data As* keeps the data object name and the project unchanged.

NEW SAVE PROJECT POLICY

When saving a project, it is now possible to choose between two options:

- Minimize the project size: only necessary data objects are saved to disk; the ones that can be recomputed will be recomputed at project loading. This is the legacy behavior.
- Minimize the project loading time: all the data of the project are saved to disk. This way no computation at project loading is necessary.

The first time you save a project in Amira 6.0, the Save Project policy dialog will be displayed, allowing you to choose the mode you prefer and to make it the default mode for subsequent projects.

You can modify the default setting at any time from the Save Project section in the General panel of the Preferences dialog.
With the new option *Include viewer background settings* you can decide to save or not the background color and mode in projects. This is disabled by default.

### NEW TEMPLATE PROJECT MECHANISM

*Template* projects can be used to make it easier to perform repetitive tasks on sets of similar data. A template project is a copy of an original project that can be conveniently reapplied on another data set of the same type.

To create a template project the user should choose *Save Project As Template...* from the File menu. Built-in template projects and known custom user template projects are loaded automatically on Amira start-up. If the template is associated with a data type the user can create an instance using the Object Popup for a data object of that type. For other templates, you can create an instance from the Templates submenu of the Create Object popup.

### NEW PORT INTERCONNECTION MECHANISM

This new feature links two ports so that modifications made to a port are automatically propagated to the connected port. Once a module is selected, clicking on its *Connection Editor* (large chain link icon) in the Properties area will display connection buttons (smaller chain link icons) next to port pin buttons. Clicking on a connection button and dragging it on top of a module containing the same port will connect them. You can also connect with another port of same type in the Properties area. Right-clicking on a connection button allows you to select the connected module or to disconnect the port. The corresponding Tcl commands are *interconnect* and *disconnect*.

### NEW UNITS MANAGEMENT

Amira 6.0 introduces a powerful new feature, **units management**. Amira can now handle coordinate unit information associated with spatial data objects, which can be specified by the user or retrieved from the data for some file formats.

By default, units management is enabled. It can be disabled from the Units panel in the Preferences dialog.
If units management is enabled, when loading a data file with unknown units, you can select the units to be used for this and subsequent files.

The *Image Read Parameters* dialog now also allows you to set the coordinate units.

A setting in the Preferences dialog specifies which units will be set when loading data files with unknown units.
The units defined for data objects are saved in project files.

When display units (units used to display values in the Amira user interface) are not locked to working units (units used internally for storage in Amira), it is also possible to quickly change the display units from the viewer panel, as an alternative to using the Preferences dialog. Note, however, that a number of modules still don’t take into account the display units setting and will still show and input working units instead.

A new option -unit has been added to the Tcl load command for persistence of file units in project scripts. Tcl commands should always use working units. Script modules can define a callback command to react to changes of display units by the user.

To learn more about units management in Amira, please refer to the chapter Units in Amira of the user’s guide.

**ENHANCED PLOT TOOL AND HISTOGRAMS**

The Plot Tool, used for histograms, curves, etc., has been enhanced as follows:

- Ticks can be optionally displayed on each axis
- Marker line labels can be offset in X and Y
- Histogram bins are now separated with a definable spacing, as long as the current zoom allows distinguishing individual bins. A border color can also be defined for histogram bins
- Zooming and panning can be disabled independently on X and Y axis. Zooming and panning along Y axis is disabled by default for histograms
- X axis is now synchronized with histogram range (port Range of module Histogram)
- Histograms are now rendered using a gradient foreground color
- The font for legends can now be changed
- The Y axis scaling can be set as logarithmic or linear by a right-click in the histogram display area
ENHANCED CROP EDITOR

The Crop Editor has new buttons for reducing or enlarging the current bounding box. This is typically useful after auto-crop. The corresponding Tcl command for data objects has been extended: `<data> crop [-auto threshold | imin imax jmin jmax kmin kmax [value]] [-enlarge adjustValue | -reduce adjustValue]`
NEW RENDERING QUALITY PREFERENCES

New options are added in the Rendering tab of Preferences. It is now possible to activate a high precision frame buffer for rendering, which can dramatically improve volume rendering quality, in particular for large semi-transparent volumes. An interactive rendering option has been added to activate simplified rendering during interaction with Volume Rendering and Isosurface Rendering modules for example.

UPGRADED LDA FORMAT

The new volume rendering engine no longer requires overlapping borders for the tiles stored in LDA files in order to prevent lighting artifacts. Therefore LDA format no longer supports the border size option, which has disappeared from the LDA Preferences panel. The recommended tile size preference remains 128.

Amira can still load older LDA files created using border size. However, when loading files using this legacy format, Amira will suggest upgrading to the new format to load data with optimal performance. The borderless file format is required for correct extraction with subsampling using Extract Subvolume.

NEW LICENSING SYSTEM IMPROVEMENTS

The reactivation of licenses is now suggested when expired licenses are found and the process automatically reactivates all expired licenses for which the maintenance is active.

Deactivation of licenses can now be done key by key.

The FlexNet license server installation and configuration webpage has been updated with many new details, examples, simplified commands, and troubleshooting tips.

Note: Amira 5.6 introduced a new licensing system, based on on-line activation. Please refer to Amira 5.6 Release Notes for all details (http://www.fei.com/software/amira-release-notes/).

NEW OFFLINE LICENSING USER INTERFACE

A new user interface for the offline activation mode has been added to allow activation of licenses on a computer with no internet connection.

This mode is almost the same as the local activation system except that an XML file containing the activation (or upgrade, reactivation, return) request is generated instead of processing the request immediately. When selecting this offline licensing mode, the different licensing dialogs and wizards are adapted to generate this XML file. This XML request file needs to be transferred to a computer with an internet connection. On this computer, you will need to open a specific web page in a web browser where you will be able to retrieve an XML response file (containing the response to your activation request). You will then need to transfer this XML response file to the computer without internet connection and import this file using the new user interface dialogs and wizards.

OPEN INVENTOR UPGRADE

Amira now uses Open Inventor 9.4 as its graphics engine. This upgrade includes bug fixes and improvements such as better performance with Delayed transparencies, a new high-performance high-quality algorithm for the Sorted Layers transparencies, and enhanced Volume Rendering performance for texture generation (non-LDM and compressed volumes).
SCRIPTING COMPATIBILITY AND ENHANCEMENTS

CONSOLE COMMANDS AND SCRIPTING COMPATIBILITY

Many module names now contain whitespaces for easier reading in the Amira user interface and in scripts. This has some impact on script commands. Module names that contain whitespaces can be written as follows in Tcl commands and scripts:

- “Ortho Slice”
- Ortho\ Slice
- {Ortho Slice}

In addition to the previously mentioned GUI label, a **CamelCase** label is now registered for all modules, lights, and tree view items. CamelCase labels do not contain spaces (words are only separated by capital letters) and may be preferred for convenience when scripting. For example, the CamelCase label for Ortho Slice is OrthoSlice.

For the objects mentioned above (modules, lights, and tree view items), both the GUI labels and the CamelCase labels can be used in the Console (see below for auto-completion) and in scripts (GUI labels are saved in saved projects but manually created scripts can use both kinds of labels interchangeably).

In the Console, when the [Tab] key is pressed, the automatic completion will insert quotation marks. Auto-completion in the Console works like this:

- From an empty console line, if you press the [Tab] key, the label of the selected module in the Project View is suggested. It will suggest the shorter of its GUI label and CamelCase label (which is often the CamelCase label). If you press the [Tab] key twice or more, it will add quotation marks around the CamelCase label.
- From few letters:
  - If there is only one possible completion, or if all the suggestions lead to the same object in the Project View, the shorter of its GUI label and CamelCase label is enclosed in quotation marks and displayed. If there are several possible completions, they are all displayed, mixing GUI labels and CamelCase labels.

Compatibility is ensured with unmodified network scripts saved by prior versions of Amira.

**MODULEAPPLY**

The new convenience command `moduleApply` is provided as an advanced Tcl example (share/resources/helpers) that can greatly help scripting: it creates a module, sets module ports, and applies the module at once in a single statement. For example:

```tcl
moduleApply HxOrthoSlice data “foam.am” sliceOrientation 2
moduleApply gaussianfilter inputImage “foam.am”
```

This command can usefully replace the deprecated `Quantification module exeCommand`.

**MODULEEXTENDER**

This command can be used to customize modules. It associates a Tcl procedure with an existing module type. That procedure is called whenever the specified module type is created by the Tcl command `create`, in a project files and with Object Popup. For example, once the following command is entered, the next Ortho Slice modules created will use XZ orientation (port value ’1’) instead of the default XY orientation:

```tcl
moduleExtender -name myOrtho -extends "HxOrthoSlice" -proc { $this sliceOrientation setValue 1 }
```
NEW COMMANDS GETSLICE/SETSLICE FOR IMAGE STACKS

New commands are now available to retrieve or replace a particular slice in an image stack (uniform scalar fields). These commands can replace in scripts the formerly used `Quantification:getPlane` and `Quantification:setPlane` commands.

getSlice xy|xz|yz <sliceNumber>
setSlice xy|xz|yz <dstSliceNumber> <srcSliceNumber> <srcSliceImage>

NEW FILE FORMATS SUPPORTED

ENHANCED SUPPORT FOR TIFF-BASED FORMATS

The range of TIFF-based formats supported in Amira has been increased.

<table>
<thead>
<tr>
<th>Image type/option</th>
<th>Amira 5.6</th>
<th>Amira 6.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tiff - multiple pages</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Tiff – strips</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Tiff – tiles</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Tiff – grayscale</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Tiff – RGB</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Tiff - color model YCbCr</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Tiff - compression LZW</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Tiff - compression jpeg</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Tiff - compression deflate</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Tiff - images size &gt; 4GB</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Zeiss LSM</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Metamorph STK</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Olympus Fluoview</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

x: supported format

NEW READER FOR .VGI AND .XTEKCT FILES

Two new readers have been added for volume description files such as created by GE Phoenix X-ray and Nikon Metrology CT scanners.

NEW READER FOR XRADIA TXM FORMAT

A new reader has been added for Xradia 3D X-ray microscopes file format. Note: This file format is only supported on Windows.

NEW READER FOR POS ATOM PROBE FORMAT

A new reader has been added for POS atom probe binary data format, including 3D points and associated mass/charge value.
NEW FORMATS FOR SURFACES: AMIRA BINARY, OPEN INVENTOR BINARY/COMPRESSED

Amira now supports a new binary format for surfaces. This is now used by default. Surfaces can now be exported to Open Inventor format as ascii or binary, compressed or not.

NEW MODULES

VOLUME RENDERING / ISOSURFACE RENDERING / VOLUME RENDERING SETTINGS

The module Volume Rendering is the successor of the modules Voltex and Voltex LDA for rendering 3D image volumes as an alternative to the familiar Volren (see also compatibility notes and a detailed table of the differences between Volren and Volume Rendering at the end of this section).

Similarly, the new module Isosurface Rendering replaces IsosurfaceRendering (LDA) for the fast rendering of isosurfaces without the computation of a triangular mesh.

A new Volume Rendering Settings module gathers the common settings used by Volume Rendering and Isosurface Rendering. The most useful settings are shown by default and an advanced mode gives the full control of the render settings, such as composition mode or slice alignment. The Volume Rendering Settings module holds the actual input connection to data.

Multiple Isosurface Rendering modules - with different thresholds and colors - can be attached to the same data associated with a unique Volume Rendering Settings. However it is not possible to attach multiple Volume Rendering modules to the same data.

The Volume Rendering module supports Multi Channel data, which allows selecting and combining the different channels for display.

An ROI Box for Volume Rendering can be attached to Volume Rendering Settings, allowing flexible clipping combinations such as "corner cuts".

Volume Rendering and Isosurface Rendering visualizations can now be picked in the 3D viewer. This is useful, for instance, when using the Quick Probe tool (see above), performing measurements, or using the module picking in 3D viewer tool (see above). The picked point is set on the first non-transparent voxel. As a consequence, you can no longer pick or drag other objects such as Ortho Slice through a volume as it was possible with Voltex. To achieve this you now need to select the Volume Rendering Settings module and toggle off the Pickable button in the Properties area.

Volume Rendering now supports shadows. To turn on the shadow effect, open the View menu and select Enable Shadows. Then for each display module, use the Shadow button located at the top right of the Properties area. Objects can cast, receive, or cast and receive shadows. You can tune shadow effects from the Rendering panel of the Preferences dialog.

The Volume Rendering and Isosurface Rendering modules have been optimized to efficiently support large data sets, in particular those that have been stored using the LDA file format (see also the tutorial How to load image data). You can further adjust quality vs. performance for interaction in several places:

- Move Low Res port in Volume Rendering Settings
• *Simplified rendering during interaction* in the Rendering panel of the Preferences dialog
• Possibly *Video Memory Amount* in the LDA panel of the Preferences dialog

**Compatibility note**

The modules *Voltex, Voltex (LDA), IsosurfaceRendering (LDA), and LDAExpertSettings* are now deprecated and no longer exposed in module menus. However these modules can still be created by scripts for compatibility.

The new *Volume Rendering* module has been developed to take advantage of modern graphics hardware. Rendering may fail on old generation graphics hardware. In some cases this can be solved by updating the graphics driver. Otherwise the module *Volren* can be tried alternatively.

**Differences between modules *Volren* and *Volume Rendering***

<table>
<thead>
<tr>
<th>Feature</th>
<th>Voltex module (deprecated)</th>
<th>Volren module</th>
<th>Volume Rendering module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse picking</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Isosurface Rendering</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Voxelized Rendering</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>DRR rendering (simulated Digitally Reconstructed Radiograph)</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>MIP rendering (Maximum Intensity Projection)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Lighting and shading effects</td>
<td>No</td>
<td>Yes Diffuse, specular</td>
<td>Yes Diffuse, specular, enhanced edge, boundary, ambient, deferred, high quality</td>
</tr>
<tr>
<td>User defined light coefficients</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Light angle control</td>
<td>No</td>
<td>Yes Port Shading: User-defined</td>
<td>Yes Use top menu View&gt;Light to Create custom light and deactivate Headlight</td>
</tr>
<tr>
<td>Cast shadows</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-Channel Field input</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Color Field input (RGBA)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Label field secondary input and per-label colormap</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Label colormap support (cycling, no interpolation)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-Volume support</td>
<td>Limited</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for data larger than graphics memory</td>
<td>Yes Very limited brickling with uniform resolution</td>
<td>Yes Full resolution when still, low resolution during interaction</td>
<td>Yes Progressive adaptive resolution, limited by memory threshold</td>
</tr>
<tr>
<td>Support for data larger than the main memory (RAM)</td>
<td>VoltexLDA becomes Volume Rendering</td>
<td>No</td>
<td>Yes With converting data into LDA format</td>
</tr>
<tr>
<td>LDA format support (Large Data Access for progressive loading, instant preview, quick extract from out-of-core data)</td>
<td>VoltexLDA becomes Volume Rendering</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### VOXELIZED RENDERING

A new module is available for voxelized volume rendering. This is useful in particular to display exact voxel boundaries of a label field or binary image. The best visual effects can be achieved by using ambient shade effect, deferred lighting, optionally with outline.

![Voxelized Rendering Example](image)

### SLICE

The **Slice** module (formerly **FilteredObliqueSlice**) now supersedes **ObliqueSlice**. New filters have been added: morphological opening and closing filters, non-local means filter.

The Apply buttons and auto-refresh can now be used to control the computation of filters. For instance, you can set auto-refresh toggle off to avoid the computation of the edge preserving smoothing filter when changing one of its parameters.

### IMAGE FILTERS

Several image filter modules have also been superseded by new modules for improved performance or extended features: **Median**, **Gaussian**, **Unsharp Masking**, **Erosion**, **Dilation**, **Opening**, and **Closing**. Note that image filters are no longer available as editors.

### EXTRACT IMAGE

The new **Extract Image** module replaces the **createImage** Tcl command available for planar modules such as **Ortho Slice**, **Slice** (formerly **ObliqueSlice** and **FilteredObliqueSlice**), **Curved Slice**, **Cylinder Slice**, and **Image Ortho Projections** (formerly **ProjectionView**). It creates image data from the currently displayed slice.

<table>
<thead>
<tr>
<th>ROI Box (Region of Interest)</th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom ROI</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Corner Cut exclusion corner</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hardware support</th>
<th>Old graphics boards</th>
<th>Modern graphics boards with updated driver e.g. NVidia Quadro</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Requires support for advanced shaders</td>
</tr>
</tbody>
</table>
COPY TRANSFORMATION

This module copies the geometric transformation (i.e., translation, rotation, scale) of a reference data set to another data set. Setting the auto-refresh toggle causes the connected data transformation to be continuously updated as the reference transformation is changed.

SYNCHRONIZE PORTS

The new Synchronize Ports module can be used to synchronize at once all ports of the two modules connected to its inputs.

CREATE AUTOMATIC LANDMARKS

This module creates landmarks from a given scalar field. The landmarks’ position is determined by the scalar field’s values, the process starting with high values and continuing until the desired number of landmarks is reached, keeping a user-defined minimum distance from each other.

AMIRA XSKELETON EXTENSION MODULES

Amira for FEI Systems now includes by default all the modules of Amira XSkeleton extension, which combines specific micro-detailed image mosaics management with advanced automatic and semi-automatic tools for reconstruction of a 3D porous, fracture, vascular, or dendritic networks from volume data. Amira online help provides a dedicated tutorial for skeletonization, as well as the list of modules in the Amira XSkeleton Extension section of the index of modules.

ENHANCED MODULES AND EDITORS

PLANAR MODULE POSITIONING IMPROVEMENTS

It is often necessary to set a plane precisely in 3D space by entering its position relative to the model rather than using 3D manipulators. A new option has been added to the existing planar modules, such as Slice, to specify the exact plane equation in four different ways: a normal and a point, a normal and a distance, a point and two vectors, and three points.
**SIMPLIFICATION EDITOR ENHANCEMENTS**

A new option is available to choose the intersection test strategy. It supersedes the Tcl command `setIntersectionTestStrategy`.

The *Simplification Editor* algorithm has been improved in order to dramatically reduce the occurrence of intersections in the computed simplified surface. Topological problems such as flat triangles, flat solid angles (two triangles overlapping), extremely close vertices, and flat edges (two triangles sharing an edge and overlapping) are now handled in a better way. Flipped normal problems should be avoided in most cases.

**GENERATE SURFACE ENHANCEMENTS**

In *Generate Surface* (formerly *SurfaceGen*), a new port *Smoothing Extent* is available if the *Smoothing* port is set to *Constrained Smoothing* or *Unconstrained Smoothing*. This port allows you to control the amount of smoothing applied when generating the surface. It supersedes the Tcl variable `SmoothKernelSize`.

Depending on smoothing type, a *Border* port option *Fit To Edges* can prevent smoothing along volume edges for keeping sharp surface edges.

![Image showing simplified surface before and after enhancement](image)

The new *Create All Patches* option has been added to create the triangles of all patches, including exterior or background regions, which can be useful, for example, if the exterior region of the input label field is to be considered during a finite element simulation.

**NEW SURFACE VIEW DISPLAY MODE – COLORFIELD MAPPING TYPE**

Surfaces can now be textured by 3D volumes (uniform scalar fields). A new port *Colorfield mapping type* specifies how colors are mapped onto surfaces when the optional color field data input port is used. With *per-vertex* mapping, the input color field is evaluated at the surface triangle vertices and colors will be interpolated in between. Color field mapping precision is therefore limited by the vertex density of the surface. With the new *per-voxel* mapping, textures are used to sample the input color field and map it accurately within surface triangles, potentially at the expense of higher memory consumption and lower performance. Note that surfaces can be simplified by using the *Simplification Editor*.

**CURVE EDITOR NEW AUTO-TRACE EDITING MODE**

A new editing mode option *auto-trace* has been added to the *Curve Editor*. When the *auto-trace* option is enabled, the *Curve Editor adds a Module* input port that can be attached to an *Ortho Slice* module. Then, the edited curve path is automatically fitted to the image edges of the attached *Ortho Slice*. Curves can be created, for instance, by *Curve* entry in main Create menu, or by *Curved Slice* entry in 3D images Display menu.
NEW SPREADSHEET DISPLAY FOR SPATIAL GRAPH OBJECTS

A spreadsheet displaying the information of a Spatial Graph object is accessible using a new Table port. Three tables are displayed, one for each kind of graph elements: Nodes, Points, and Segments. The Nodes and Points tables are composed of the IDs, attributes, and 3D coordinates. The Segments table is composed of the segment IDs, attributes, source ID, target ID, and the list of the point IDs composing the segments. This spreadsheet can be exported in Microsoft XML Spreadsheet 2003 format.

When a Spatial Graph View module is connected to a Spatial Graph object, it is now possible to highlight nodes, points, and segments by selecting them in the Spatial Graph inner spreadsheet.

TRIDELITY VIEW

The Tridility View module, now accessible from Stereoscopic Display entry in the View top menu, supports new Tridility auto-stereoscopic displays.

CALCULUS MATLAB

The Calculus Matlab module supports MATLAB 2014a version (and earlier).

PERFORMANCE IMPROVEMENTS

GENERATE SURFACE

The memory consumption of Generate Surface (formerly SurfaceGen) has been dramatically reduced when using multiple CPU cores.

HISTOGRAM COMPUTATION

The histogram computation has been enhanced to take advantage of multi-CPU systems. The histogram computation is used in several Amira tools, for instance when launching the Segmentation Editor.

MOVIE PLAYER

Performance of the Movie Player module has been improved significantly by using recent GPU hardware acceleration when possible.
Amira for FEI Systems 6.0 now also includes Amira XImagePAQ extension, the advanced Image Processing, Analysis, and Quantification extension.

Amira XImagePAQ extension is a major evolution of the prior Amira Quantification+ option, including important enhancements, many new features and substantial performance improvements. Amira XImagePAQ extension also includes all modules of the prior Amira Multi-Component Analysis option, which was already part of Amira for FEI Systems previous versions.

**QUANTIFICATION MODULE REPLACED BY NEW MODULES AND COMPONENTS**

The *Quantification* module of the prior Amira Quantification+ option is now deprecated and has been replaced by a large set of Amira native modules and components included in the XImagePAQ extension and Amira for FEI Systems.

The *Quantification* module is no longer exposed in Amira menus, but it can be created by scripts or by console command (`create HxVisilog`).

However it is highly recommended that you update your existing scripts and projects to the new available module set, for benefits in performance, features, multi-platform availability, and future compatibility.

The new Object Popup has an integrated search tool that can quickly retrieve modules corresponding to former commands of the *Quantification* module, or other different legacy names.

The index table linked from Switching to Amira 6 in the help index page also provides for each command of the former *Quantification* module, the corresponding new module name and category.

For help updating custom Tcl scripts, see the new command `moduleApply` in section *Scripting enhancements and new commands*.

The *Interpretation* port has been introduced in most modules for choosing 3D or slice-by-slice processing, when applicable. This corresponds to the *Interpretation* port of the deprecated *Quantification* module, and has been extended to more modules.

The *Neighborhood* port has been introduced for choosing connectivity processing by face, edge, or corner, when applicable. This replaces the former *Quantification:neighborhood* command.

For out-of-core processing, a number of modules can take as input Visilog .im6 files loaded as "on-disk" external data. This enables processing of data without loading it fully in memory, as was possible with the *Quantification* module. In most cases then, data slabs are loaded, processed, and saved in turn. This allows processing of data that is much larger than the available memory on your system, at the expense of processing time. By default, a module using "on-disk" input will ask for a filename for saving its result on disk. You may enable a port for choosing memory or disk output with the following Tcl command: `<module-name> outputLocation show`. For convenience, the modules supporting out-of-core processing can now also take as input .lda files (Large Data Access format for streamed loading,
out-of-core visualization, and quick subvolume extraction). However the .im6 format is still preferred for best out-of-core processing performance.

Many new modules have also been introduced to supersede commands of the Quantification module:

- **Image Processing** category: extended image filters, extensive morphological tools, shading correction...
- **Image Segmentation** category: top-hat, marker-based watershed, separation, automatic thresholding...
- **Measure and Analyze** category: individual label analysis, global image analysis, morphometric extensions...

### MULTI-COMPONENT ANALYSIS MODULES

Amira for FEI Systems includes the prior Multi-Component Analysis option modules, namely:

- **Filter By Spreadsheet** (creates a filtered label field object from a spreadsheet)
- **Hierarchical Watershed** (formerly WatershedSegmentation module, see dedicated section below)
- **Local Thresholding** (provides automated threshold segmentation algorithms)
- **Point Cloud Density** (computes the density of a Point Cloud – new designation for Cluster)
- **Spreadsheet Filter** (filters spreadsheets for various aspects and prepares their data for visualization)
- **Spreadsheet to Point Cloud** (creates a Point Cloud, a Tensor, or a Line Set object from a spreadsheet)

The MorphologicalSeparation module is now deprecated and Separate Objects should be used instead.

The ShapeAnalysis module is now deprecated and the Standard shape analysis and Weighted shape analysis measure groups now supersede the ShapeAnalysis module (see section dedicated to Global Analysis and Label Analysis below).

To ensure compatibility, deprecated modules can still be created by scripts.

### NEW MODULES AND FEATURES

#### INTERACTIVE THRESHOLDING

The Interactive Thresholding module supersedes Quantification-Threshold with the following enhancements:

- A fast preview can be displayed in 2D or 3D.
- A unique Intensity Range port is used for minimum and maximum thresholds.
ADAPTIVE THRESHOLDING

This new module computes the threshold of a grayscale image given a label image corresponding to the pre-segmentation of the original image, and outputs a binary image. Instead of giving two fixed values for the thresholding, the user chooses two representative measures (e.g., the 10th and the 90th percentile of the histogram). The min and max threshold values are then dynamically computed for each label, which gives an individual thresholding on each label.

AUTO THRESHOLDING

This module computes a threshold based on the histogram of the input image using one of the following specified criterion: Entropy, Factorisation, Moments or IsoData. It then outputs a binary image of voxels below or above the calculated threshold, depending on the chosen option (Auto Threshold Low or Auto Threshold High). It also has a third option, Auto Segment 3 Phases, to compute a 2-level threshold based on one of the specified criterion mentioned above, without prompting the user for input, and outputs a label image with two non-zero levels.

HYSTERESIS THRESHOLDING

This new module replaces the Hysteresis option of the former LocalThreshold module.

NEW AUTOMATIC INTENSITY RANGE PARTITIONING

When loading 3D image data, the new automatic intensity range partitioning tool computes a set of values representing possible thresholds between phases in the data set based on a gradient method. The set of values (so called intensity ranges) are then directly usable in all modules having a threshold value slider port, or colormap port, such as Isosurface, Ortho Slice, and Volume Rendering.

A new Preferences tab Range Partitioning allows control of this feature. Range partitioning is disabled by default. When enabled, you can choose to define the number of regions that must be computed or let the algorithm detect this number automatically. The data window then computed will be used to initialize the colormap range of 3D display modules such as Volume Rendering and for intensity-related ports such as threshold segmentation ports. Any other display module colormap range will be initialized with the data min-max range unless option Use only for 3D boundaries displays and segmentation thresholds is disabled.
**ANISOTROPIC DIFFUSION IMAGE FILTER**

The new *Anisotropic Diffusion* filter module, available from the *Image Processing > Smoothing And Denoising* category, is a very powerful tool for enhancing noisy or non-uniform images for purpose of segmentation. Similar to the *Edge Preserving Smoothing* filter, this module is accelerated by multiple cores or by the GPU.

**FILTER SANDBOX**

This new convenience module can be used to preview the effect of an image filter on a part of an image, and then apply it on the entire image. It is available in the image object’s menu *Image Filters*. The filter can be: *Bilateral, Box, Gaussian, Median, Recursive, Delineate, Anisotropic Diffusion, Non-Local Means, and Unsharp Masking*. Filters can be applied in 2D or in 3D (*Anisotropic Diffusion* is 3D only, and *Non-Local Means* may be preferred in 2D mode for performance). In 3D mode, for preview, the filter is applied to a slab on the region of interest. The effect of a filter on the thresholding segmentation can be visualized. You can display means, standard deviations and histograms before and after applying the filter. Advanced users that are familiar with Tcl scripting can extend this module for more filters or a specific purpose.

**NEW CYCLIC COLORMAPS**

The two colormaps *labels* and *labelsBinary* have been introduced for label images or binary images. These colormaps use new properties for cyclic colors and for preventing color interpolation across values.

**INTERACTIVE TOP-HAT**

A new module is available for interactive Top-Hat transform, used commonly for image segmentation of small local features. This module works as a two-step wizard: first define the closing/opening operation used to isolate small local dark or bright features of given size, then threshold the features’ contrast depth.

**GLOBAL ANALYSIS AND LABEL ANALYSIS**

The new modules *Global Analysis* and *Label Analysis* are available for quantitative analysis of binary or label images (former *Quantification* commands *global_analyze* and *I_analyze*). These modules allow selecting or defining a group of measures to be applied globally to a binary image or individually for each label in a label image.

The measures group selection dialog is used to add or remove from the measure group either predefined measures or user-defined measures.
The measure editor can be used to define new custom measures. The syntax of the custom measures' formula is checked and validated on the fly.

Some measures have configurable attributes.

When applied, the analysis modules create new analysis data objects (specialized spreadsheet type $HxLabelAnalysis$), that are automatically displayed in the Tables Panel.

The *Standard shape analysis* and *Weighted shape analysis* measure groups are available from the *Measures* drop-down list and supersede the *ShapeAnalysis* module. The second group takes into account the gray intensity of the input data.

---

**NEW ANALYSIS RESULT VIEWER**

A new component is available for displaying global or individual analysis results within the dockable Tables Panel. A statistics summary is displayed at the top of the viewer. On top of it a toolbar allows you to:

- copy data to the clipboard,
- export data,
- sort rows,
- plot the results column selected in the bottom panel,
- pick a row to track the location of a particular label.
Like the former Result Viewer, you can select a row to highlight the corresponding 3D location or pick a 3D location to retrieve a measure. Results can be plotted as histograms for individual measures, or as profiles per slice for global measures (using Interpretation XY in Global Analysis and curve setting in Plot Tool).

**ANALYSIS FILTER**

The new Analysis Filter module creates a new analysis and a corresponding label field-based on a filter expression using one or more measures. Selecting a measure in the measures list shows the corresponding histogram and adds the measure name in the expression. In the histogram plot, you can drag the vertical marker line then double-click on it to copy the corresponding value in the expression.

**SIEVE ANALYSIS**

The new Sieve Analysis module classifies labels in the input image according to the defined sieve, i.e., groups the labels by measure value ranges, and produces a label image corresponding to the defined classes. In the plot area you can drag marker lines or middle-click to add a marker line. Pressing the detect button will distribute the ranges evenly.
**ANALYSIS TO SPREADSHEET**

The new module *Analysis To Spreadsheet* converts an analysis table resulting from *Label Analysis or Global Analysis* into a generic spreadsheet data object.

**LABEL TO ATTRIBUTE**

*Label To Attribute* creates a volume filled with label measures contained in a *Label Analysis*, based on a label image. The output field will have the same dimension as the label image.

**VOLUME FRACTION**

This module computes the volume fraction (porosity) of materials or phases in a binary or label image, with an optional mask defining the reference volume. This module outputs a spreadsheet with one row per label, or per label and per slice, giving absolute volumes, voxel counts, and volume fractions. This module replaces the following *Quantification* commands: *image_volume, object_image_ratio, object_volume, volume, and volume3d*.

**WATERSHED SEGMENTATION AND HIERARCHICAL WATERSHED**

The former *WatershedSegmentation* module has been renamed to *Hierarchical Watershed*.

*Watershed Segmentation* is a new parallelized module that performs an accurate segmentation of different phases by applying a watershed on the high gradient magnitude.

**MARKER-BASED WATERSHED**

This new module performs a fast determination of the watershed lines from specified markers in a label image. It has two main configurations: *Watershed* and *Catchment Basins*. In *Watershed* mode, it determines the crest lines separating the markers and outputs the crest lines in a binary image. In *Catchment Basins* mode, the determination of the watershed lines is followed by a labelling of the complementary regions, which can be viewed as the zones of influence of the markers. The separated basins are stored in a label image.

**2D-HISTOGRAM SEGMENTATION**

Using the *2D-Histogram Segmentation* script module, you can do semi-automatic segmentation of your CT or MR gray level images data composed of two or more phases.
SHADING CORRECTION WIZARD

This wizard performs a correction of the shading from a pre-computed background defined with a mask by the user. Then the wizard computes the background image using the `Quantification bkimg` command with the previously selected mask and finally performs the shading correction using the `Quantification shading_cor` command.

AXIS CONNECTIVITY

Given two parallel planes and a binary (or label) input image, Axis Connectivity generates a binary image containing all path linking planes. The two planes are a couple of parallel faces of the image's bounding box (the XY, XZ, or YZ faces).

RULED SURFACE

This new module builds a surface by joining two input curves with a set of triangles. The input curves can be either Line Set or B-Spline data. The resulting surface is a ruled surface. Volume data can be mapped on surfaces (see the new Surface colorfield mapping type above) and a new Extract Image module is available to create flattened images of ruled surfaces with mapped colorfield (see below).

EXTRACT IMAGE FOR RULED SURFACES

This new module can attach to a Surface View module displaying a surface that has been generated by the module Ruled Surface, with per-voxel colorfield mapping. Extract Image can then create a flattened 2D image of the input surface with the mapped colorfield.

CURVE MORPHING

This new module interpolates two input curves of type Line Set or B-Spline. This can be used, for instance, in combination with Curved Slice or Ruled Surface modules for animating a surface with a mapped colorfield.

CONVEX HULL

The Convex Hull module allows you to compute an approximation of the convex hull of arbitrary point sets, line sets, surfaces or grids. The computed output is given as a triangulated surface.

NEW IMAGE PROCESSING FEATURES

A number of new image processing and analysis features come with Amira XImagePAQ 6.0, including:

- New Disc and Ball morphological kernels in morphological operation modules
- New Image Gradient with extended features
- Extended Gaussian Filter
- New Flow Inpainting filter
New Local Orientation module
New Curvature module
New Curvature-Driven Diffusion module
New Bilateral Filter module

SPLIT CONNECTED COMPONENTS

The new module Split Connected Components extracts from the input image a set of subvolumes surrounding the largest connected components. You can specify the number of components, the segmentation thresholds, and optional masking of exterior or extraneous components. This module creates a new image data object for each extracted subvolume.

Note: This module is currently available only on Windows.

INTENSITY INTEGRAL

The new module Intensity Integral computes slice by slice or in the whole 3D volume the sum of voxel intensities of an image or uniform scalar field. The image analysis result can be displayed in the Tables Panel.
NEW XWIND EXTENSION – ADVANCED CFD/FEA DATA EXTENSION

The new Amira XWind extension includes dedicated visualization and computation modules, readers and writers for advanced Finite Element Analysis (FEA) and Computer Fluid Dynamics (CFD) data processing, and analysis. XWind is used for applications such as flow, stress, and thermal analysis.

The Amira XMesh extension provides support for image-to-simulation workflows with mesh generation and basic post-processing visualization of simulation data. XWind extends XMesh with advanced support for:

- Post-processing of result data coming from solvers:
  - Import from major FEA/CFD file formats (see the list below)
  - Robust support for unstructured mixed meshes
  - Powerful visualization and analysis of scalar, vector, and tensor fields, coming from either simulation or measurements
  - Flexible probing and measurements
  - Extensive computation of derived variables and statistics on simulation results
  - Advanced feature extraction tools such as vortex core lines or critical points

- Pre-processing from image data to simulation:
  - Export of surfaces or 3D meshes to numerical solvers (see the list below)

Most FEA/CFD file formats are supported in XWind extension:

<table>
<thead>
<tr>
<th>Format</th>
<th>Latest supported version</th>
<th>Read (r) and write (w) capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSYS</td>
<td>14.5</td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>ANSYS Input</td>
<td>14.5</td>
<td>CAE/CFD grids (rw)</td>
</tr>
<tr>
<td>Abaqus</td>
<td>6.12</td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>Abaqus Input</td>
<td>6.12</td>
<td>CAE/CFD grids (read up to 6.12, write up to 6.10)</td>
</tr>
<tr>
<td>CGNS</td>
<td>3.1</td>
<td>CAE/CFD grids (rw) and simulation data (r)</td>
</tr>
<tr>
<td>Enight</td>
<td>6/Gold</td>
<td>CAE/CFD grids (rw) and simulation data (r)</td>
</tr>
<tr>
<td>FIDAP Neutral</td>
<td>7.6</td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>Fluent/UNS</td>
<td>12.1</td>
<td>CAE/CFD grids (rw) and simulation data (r)</td>
</tr>
<tr>
<td>LSTC LS-Dyna</td>
<td>970.0</td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>LSTC LS-Dyna Input</td>
<td>970.0</td>
<td>CAE/CFD grids (r)</td>
</tr>
<tr>
<td>NASA/Plot3D</td>
<td></td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>Nastran Bulk Data</td>
<td>2010</td>
<td>CAE/CFD grids (rw)</td>
</tr>
<tr>
<td>Nastran Output2</td>
<td>2010</td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>OpenFOAM</td>
<td>2.0</td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>SDRC/IDEAS Universal</td>
<td>NX Series 11</td>
<td>CAE/CFD grids (rw) and simulation data (r)</td>
</tr>
<tr>
<td>STAR-CCM</td>
<td>2.06</td>
<td>CAE/CFD grids and simulation data (r)</td>
</tr>
<tr>
<td>Tecplot</td>
<td>11.2</td>
<td>CAE/CFD grids (rw) and simulation data (r)</td>
</tr>
</tbody>
</table>
**XPAND EXTENSION**

The Amira Developer option now becomes the XPand extension, the developer kit extension.

**SUPPORT FOR MICROSOFT VISUAL STUDIO**

The Amira XPand extension is now provided for Microsoft Visual Studio 2010 (VC10).

**NEW XPAND EXAMPLES FOR CUDA AND OPENCL COMPUTE MODULES**

New tutorials and examples show how to create Amira compute modules that take advantage of the GPU using CUDA or OpenCL.

**XSCREEN EXTENSION**

The Amira Virtual Reality option now becomes the XScreen extension, the advanced display and virtual reality extension.

**EASIER CONFIGURATION OF THE FLAT DISPLAYS IN XSCREEN**

Creating XScreen configurations requires manual creation of a complex description file. For flat screen configurations, a new interactive tool called *Create Flat Configuration* is provided from the Configurations entry of the XScreen menu.

**OPERATING SYSTEMS**

Amira for FEI Systems 6.0 runs on Microsoft Windows 7/8 (32-bit and 64-bit).

In order to add custom extensions to Amira for FEI Systems with Amira **XPand**, you will need Microsoft Visual Studio 2010 (VC++ 2010) and its Service Pack 1 on Windows. Amira for FEI Systems 6.0 will be the last version to support Microsoft Visual Studio 2010.
### SOLVED ISSUES

Amira for FEI Systems 6.0 provides many enhancements and solutions to known problems, including the following:

<table>
<thead>
<tr>
<th>Category</th>
<th>Issue ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arithmetic</td>
<td>28385 (4102)</td>
<td>Using <code>rand()</code> as first expression in <code>Expr</code> port no longer causes failure.</td>
</tr>
<tr>
<td>Auto Slice &amp; View Reader</td>
<td>30789</td>
<td>Empty series will not be imported and if the ASV file contains only empty series, an error message will be displayed.</td>
</tr>
<tr>
<td>Block Face Correction</td>
<td>32065</td>
<td>Input data that exceeds 2 GB is now supported.</td>
</tr>
<tr>
<td>BMP Reader</td>
<td>27841 (3558)</td>
<td>[Mac OS X] It is now possible to import BMP files, regardless of the extension capitalization (.BMP, .bmp, ...).</td>
</tr>
<tr>
<td>B-Spline</td>
<td>28311 (4028)</td>
<td>34530</td>
</tr>
<tr>
<td>Camera Orbit</td>
<td>27915 (3632)</td>
<td>The Recompute button now generates camera path by analyzing the camera of the active viewer.</td>
</tr>
<tr>
<td>Camera Path</td>
<td>27873 (3590)</td>
<td>Activating the Camera Path Editor could generate corrupted visualization of the scale bar in the Viewer. This has been fixed.</td>
</tr>
<tr>
<td>Clipping Plane</td>
<td>29581</td>
<td>Clipping is supported on Intel HD and Radeon HD graphic cards.</td>
</tr>
<tr>
<td>Color Wash</td>
<td>33228</td>
<td>The Alpha port of Label Blending mode has been renamed to Transparency to be consistent with the overlay label vanishing with port’s value increase.</td>
</tr>
<tr>
<td>Colormap Editor</td>
<td>29602</td>
<td>Histogram of Surface Scalar Field data can now be displayed in the Colormap Editor.</td>
</tr>
<tr>
<td>Convert Image Type</td>
<td>27774 (3491)</td>
<td>Deprecated CastLattice module could generate zero-filled data as float output. Replacing module Convert Image Type fixes this issue.</td>
</tr>
<tr>
<td>DICOM Reader</td>
<td>29407</td>
<td>DICOM data can now be loaded as Time Series Data.</td>
</tr>
<tr>
<td></td>
<td>26926 (2643)</td>
<td>Imported data might have corrupted data range. This has been fixed.</td>
</tr>
<tr>
<td></td>
<td>30671</td>
<td>Pixel spacing is now read in the correct order.</td>
</tr>
<tr>
<td>DICOM Writer</td>
<td>26274 (1991)</td>
<td>Data object can now be exported as DICOM data.</td>
</tr>
<tr>
<td></td>
<td>28846</td>
<td>30980</td>
</tr>
<tr>
<td>Display Legend</td>
<td>28399 (4116)</td>
<td>Text color can be changed whatever the colormap is.</td>
</tr>
<tr>
<td>Filament Editor</td>
<td>30152</td>
<td>Filament Editor’s interactive tracing failed in thin structures mode. This has been fixed.</td>
</tr>
<tr>
<td></td>
<td>32855</td>
<td>An error occurring on displaying Graph Info has been solved.</td>
</tr>
<tr>
<td></td>
<td>31429</td>
<td>A failure occurring on editing Window Level has been fixed.</td>
</tr>
<tr>
<td></td>
<td>29689</td>
<td>Graph Data labeling was incorrect on saving/reloading. It has been fixed.</td>
</tr>
<tr>
<td></td>
<td>30324</td>
<td>Graph segment can now be selected in the viewer without failure.</td>
</tr>
</tbody>
</table>

Amira for FEI Systems 6.0 release notes – FEI© 2015
<table>
<thead>
<tr>
<th>Issue Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>32561</td>
<td>The Image Data object is rendered now, even if it is a label field.</td>
</tr>
<tr>
<td>30036</td>
<td>Issues to quit full screen mode have been solved.</td>
</tr>
<tr>
<td>31205</td>
<td>16-bit label fields stored in uniform scalar fields with a special parameter bundle VisilogBinary or VisilogLabel are no longer supported as inputs of Generate Surface and must be first converted to label fields.</td>
</tr>
<tr>
<td>33893</td>
<td>Material names associated with the input label field are no longer deleted.</td>
</tr>
<tr>
<td>27885 (3602)</td>
<td>Surfaces that exceed 2 GB of memory can now be generated.</td>
</tr>
<tr>
<td>27291 (3008)</td>
<td>Projects containing Image Ortho Projections (formerly ProjectionView) modules didn’t always display the same result at reloading. This has been fixed.</td>
</tr>
<tr>
<td>28296 (4013)</td>
<td>Label fields that exceed 2 GB are now supported.</td>
</tr>
<tr>
<td>28121 (3838)</td>
<td>An issue with landmarks positioning has been fixed.</td>
</tr>
<tr>
<td>33543</td>
<td>Converting AmiraMesh files to LDA files could fail in some special cases. This has been fixed.</td>
</tr>
<tr>
<td>28382 (4099)</td>
<td>Converting 8-bit indexed TIFF files to LDA file could fail in some special cases. This has been fixed.</td>
</tr>
<tr>
<td>31741</td>
<td>LEICA series are loaded into the Project View in the correct order.</td>
</tr>
<tr>
<td>28352 (4069)</td>
<td>Files can be correctly sorted by name in the Load File dialog.</td>
</tr>
<tr>
<td>26824 (2541)</td>
<td>Failure on loading large LSM files has been fixed.</td>
</tr>
<tr>
<td>27919 (3636)</td>
<td>The Frame Rate port could have no effect on generated AVI movies. This has been fixed.</td>
</tr>
<tr>
<td>28289 (4006)</td>
<td>No more error occurs on deleting multi-channel fields.</td>
</tr>
<tr>
<td>33271</td>
<td>Replacing a data object associated with a channel no longer changes the order of the channels.</td>
</tr>
<tr>
<td>27356 (3073)</td>
<td>Changing material name in the Segmentation Editor could result in a different color for the same material in the Multiplanar Viewer. This has been fixed.</td>
</tr>
<tr>
<td>31851</td>
<td>Large data are now supported.</td>
</tr>
<tr>
<td>28061 (3778)</td>
<td>Clipping plane could switch to opposite side while scrolling through slices. This has been fixed.</td>
</tr>
<tr>
<td>30623</td>
<td>Loading PLY files no longer fails.</td>
</tr>
<tr>
<td>26720 (2437)</td>
<td>Commands of former Quantification module have been replaced with new modules. These modules don’t fail on large data.</td>
</tr>
<tr>
<td>29383</td>
<td></td>
</tr>
<tr>
<td>27029 (2746)</td>
<td>Commands of former Quantification module have been replaced with new modules. These modules consider the right input data.</td>
</tr>
<tr>
<td>Issue Number</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>27964 (3681)</td>
<td>Threshold command of former Quantification module has been replaced with Interactive Thresholding module and there is no longer an issue with swapped minimum coordinates values.</td>
</tr>
<tr>
<td>28066 (3783)</td>
<td>Threshold command of former Quantification module has been replaced with Interactive Thresholding module and results are now valid.</td>
</tr>
<tr>
<td>29382</td>
<td>Commands of former Quantification module have been replaced with new modules. The bounding box and voxel size of the resulting data are the same as the input data’s.</td>
</tr>
<tr>
<td>RAW reader</td>
<td>28199 (3916)</td>
</tr>
<tr>
<td>Relabel</td>
<td>28243 (3960)</td>
</tr>
<tr>
<td>Remesh Surface</td>
<td>27045 (2762)</td>
</tr>
<tr>
<td>Resample</td>
<td>28003 (3720)</td>
</tr>
<tr>
<td>Save/Export</td>
<td>31287</td>
</tr>
<tr>
<td>Scalebars</td>
<td>27982 (3699)</td>
</tr>
<tr>
<td>Script Objects</td>
<td>25863 (1580)</td>
</tr>
<tr>
<td>Secondary Structure View</td>
<td>33947</td>
</tr>
<tr>
<td>Segmentation Editor</td>
<td>29972</td>
</tr>
<tr>
<td></td>
<td>29735</td>
</tr>
<tr>
<td></td>
<td>28495</td>
</tr>
<tr>
<td>Snapshot Tool</td>
<td>33534</td>
</tr>
<tr>
<td></td>
<td>25515 (1232)</td>
</tr>
<tr>
<td>Spatial Graph View</td>
<td>32114</td>
</tr>
<tr>
<td></td>
<td>32571</td>
</tr>
<tr>
<td></td>
<td>30015</td>
</tr>
<tr>
<td></td>
<td>20353</td>
</tr>
<tr>
<td></td>
<td>29341</td>
</tr>
<tr>
<td>Start Amira</td>
<td>31665</td>
</tr>
<tr>
<td>Section</td>
<td>Issue Number</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Surface Cross Section</td>
<td>32665</td>
</tr>
<tr>
<td>Surface Editor</td>
<td>28342 (4059)</td>
</tr>
<tr>
<td>TIFF Reader</td>
<td>28073 (3790)</td>
</tr>
<tr>
<td></td>
<td>28008 (3725)</td>
</tr>
<tr>
<td>Transform Editor</td>
<td>27796 (3513)</td>
</tr>
<tr>
<td>Uniform Scalar Field</td>
<td>28246 (3963)</td>
</tr>
<tr>
<td>Viewers</td>
<td>30146</td>
</tr>
<tr>
<td></td>
<td>27480 (3197)</td>
</tr>
<tr>
<td>Volren</td>
<td>27929 (3646)</td>
</tr>
<tr>
<td></td>
<td>27934 (3651)</td>
</tr>
<tr>
<td></td>
<td>27928 (3645)</td>
</tr>
<tr>
<td>Volume Edit</td>
<td>28406 (4123)</td>
</tr>
<tr>
<td></td>
<td>28390</td>
</tr>
</tbody>
</table>

Our team permanently focuses on solving as many issues as possible to make your experience of Amira as satisfactory as possible. To this purpose, we would appreciate your feedback regarding this version. If you encounter problems, or if you have suggestions for improvement, please report them to vsghotline@fei.com.